
Introduction to Excel
Revised version

Screenshots are taken from Excel 2013. Earlier and later versions may look different.



In this presentation, we will have a quick look at the uses for Excel, as well as taking a tour of 
how it appears on your screen and looking at the most important parts of the screen. 

Excel’s forte is performing numerical calculations, but Excel is also very 
useful for non-numeric applications.
Here are just a few of the uses for Excel:

• Number crunching: Create budgets, tabulate expenses, analyse survey results, 
and perform just about any type of financial analysis you can think of.

• Creating charts: Create a wide variety of highly customizable charts.
• Organizing lists: Use the row-and-column layout to store lists efficiently.
• Text manipulation: Clean up and standardize text-based data.
• Accessing other data: Import data from a wide variety of sources.
• Creating graphical dashboards: Summarize a large amount of business 

information in a concise format.
• Creating graphics and diagrams: Use Shapes and SmartArt to create 

professional looking diagrams.
• Automating complex tasks: Perform a tedious task with a single mouse click 

with Excel’s macro capabilities.



Start Excel

Click on the Excel icon          in All Apps, (some versions can be found under Microsoft Office). Alternatively click on any
shortcut you may have on the taskbar, start screen or desktop.

The Excel window has a left-hand panel listing 
recently-opened workbooks which you can 
select to continue working with. The right-hand 
area of the screen has large icons, starting with 
“Blank workbook” and “Welcome to Excel”. 

Then follows a series of templates for different 
accounting and charting functions. 
If you need a different template you can also 
look for one online using the search box at the 
top of the screen, or create one yourself 
starting with a blank workbook.

Whenever you acquire a newer version of Excel 
it is well worth opening the “Welcome to Excel” 
spreadsheet to see what new features are 
included.



The work you do in Excel is performed in a workbook file. You can have as many workbooks open as you need, and 
each one appears in its own window. By default, Excel workbooks use an .xlsx file extension, but Excel also happily 
works with its older .xls file format as well as the Open Document Spreadsheet (.ods) files and Comma Separated 
Values (.csv) files. You may occasionally also encounter Excel template files (.xlt, .xltx, .xltm) Excel add-in files (.xla
and .xlam) and specialised Excel files such as .xlsb and .xlsm. File suffixes ending with m are macro-enabled, 
meaning that built into them are routines which can run automatically when the file is opened. If you ever 
receive this type of file you may get a warning and it is as well to heed this warning, particularly if you receive it 
from someone you do not know well, as the routine can open other programs on your computer and can 
therefore infect it with malware. 

Each workbook contains one or more worksheets, and each worksheet is made up of individual cells. Each cell can 
contain a value (numerical, currency, date, time, fraction, etc), a formula, or text. A worksheet also has an invisible 
draw layer, which holds charts, images, and diagrams. Each worksheet in a workbook is accessible by clicking the 
tab at the bottom of the workbook window. In addition, a workbook can store chart sheets; a chart sheet displays 
a single chart and is also accessible by clicking a tab.

Excel can seem intimidating to newcomers because of all the different elements that appear within Excel’s 
window. It is well worth persevering, however, as Excel is an incredibly powerful and versatile program capable of 
a multitude of tasks. Bill Gates, founder of Microsoft, once described Excel as the program of which he was 
proudest. After you become familiar with the various parts it all starts to make sense, and you’ll feel right at home.



A normal Excel worksheet looks like this:

In the next few slides we’ll identify various elements and give a brief explanation of their functions.



The active cell is shown here and its reference is shown in the yellow-highlighted area just below the ribbon.

Column letters run along the top of the working area, and 
row numbers run down the left-hand side. The letter and 
number which constitute the reference of the active cell are 
both highlighted.

Every worksheet consists of rows (numbered 1 to 1,048,576) and columns (labelled A to XFD). Column labelling works like 
this: After column Z comes column AA, which is followed by AB, AC, and so on. After column AZ comes BA, BB, and so on. 
After column ZZ is AAA, AAB, and so on.
The intersection of a row and a column is a single cell, and each cell has a unique address made up of its column letter and 
row number. For example, the address of the upper-left cell is A1. The address of the cell at the lower right of a worksheet 
is XFD1048576.
At any given time, only one cell of the 17 billion (17,179,869,184 to be exact, although earlier editions of Excel had fewer 
cells on each worksheet) on the sheet is the active cell. The active cell is the cell that accepts keyboard and mouse input, 
and whose contents can be edited. You can identify the active cell by its darker border. 



You can move 
around the working 
area using the 
vertical and 
horizontal scrollbars. 

The worksheets
contained in the 
workbook are shown 
by these tabs.

Add a new 
worksheet 
by clicking 
the plus sign.

Right-click any 
worksheet tab for 
options including 
renaming, hiding, 
and deleting the 
sheet, as well as 
recolouring the tab. 

The status bar runs 
along the bottom of the 
screen. Right-click it for 
a list of options, 
including showing 
whether Caps Lock and 
Number Lock are on.

The zoom slider lets 
you zoom in and out. 
If it is not visible you 
can enable it by 
right-clicking the 
status bar.



In Office 2007, Microsoft made a dramatic change to the user interface. Traditional menus and toolbars were replaced 
with the Ribbon, a collection of icons at the top of the screen.
The words above the icons are known as tabs: the Home tab, the Insert tab, and so on. Most users seem now to find that 
the Ribbon is easier to use than the old menu system; it can also be customized to make it even easier to use.

The Ribbon can either be hidden or visible (it’s your choice). To toggle 
the Ribbon’s visibility, press Ctrl+F1 (or double-click a tab at the top). 
If the Ribbon is hidden, it temporarily appears when you click a tab 
and hides itself when you click in the worksheet. The title bar has a 
control named Ribbon Display Options (next to the Help button). Click 
the control and choose one of three Ribbon options: Auto-hide, Show 
Tabs, or Show Tabs and Commands.



The commands available in the Ribbon vary, depending upon which tab is selected. The Ribbon is arranged into groups 
of related commands. Here’s a quick overview of Excel’s tabs:
• Home: You’ll probably spend most of your time with the Home tab selected. This tab contains the basic Clipboard 

commands, formatting commands, style commands, commands to insert and delete rows or columns, plus an 
assortment of worksheet editing commands.

• Insert: Select this tab when you need to insert something in a worksheet — a table, a diagram, a chart, a symbol, 
and so on.

• Page Layout: This tab contains commands that affect the overall appearance of your worksheet, including some 
settings that deal with printing.

• Formulas: Use this tab to insert a formula, name a cell or a range, access the formula auditing tools, or control how 
Excel performs calculations.

• Data: Excel’s data-related commands are on this tab, including data validation commands.
• Review: This tab contains tools to check spelling, translate words, add comments, or protect sheets.
• View: The View tab contains commands that control various aspects of how a sheet is viewed. Some commands on 

this tab are also available in the status bar.
• Developer: This tab isn’t visible by default. It contains commands that are useful for programmers. To display the 

Developer tab, choose File ➪ Options and then select Customize Ribbon. In the Customize the Ribbon section on 
the right, make sure Main Tabs is selected in the drop-down control, and place a check mark next to Developer.

• Add-Ins: This tab is visible only if you loaded an older workbook or add-in that customizes the menu or toolbars. 
Because menus and toolbars are no longer available in Excel 2013, these user interface customizations appear on 
the Add-Ins tab.

This list contains the standard Ribbon tabs. Excel may display additional Ribbon tabs, resulting from add-ins or macros. 
For yet more information about the Ribbon, see the separate Ribbon presentations.



It is worth looking at formatting, available from the “Home” tab on the ribbon. Apart 
from the usual choice of fonts, font sizes and colours, left- or right-alignment or centring 
text, etc., there is a range of ways in which cells can be formatted. Click on Format Cells 
or right-click and select “format cell” to see this menu:

The “Number” tab is particularly important, as Excel is 
great for working with numbers. 
The cell format determines whether, for example, the 
number is a currency or just a number, and how many 
decimal places to display. When performing 
calculations Excel will always use the core cell value 
rather than the value displayed (e.g. if you have 
formatted the cell to display no decimal places).
The following slide shows some of the different ways 
Excel can display numbers.



Formatting numbers in Excel

Let's start with small numbers: 1.25 for example. 
The top row below contains 1.25 in every case, while the row below shows the way in which that cell has been formatted.

1.25 1.25 1.3 1 1 1/4 1  1/4 £1.25 125.00%1.25

General 
format

Number 
format, 2 
decimal 
places

Number 
format, 1 
decimal 

place

Number 
format, no 

decimal 
places

Fraction 
format, 

up to 1 digit

Fraction 
format, 

up to 2 digits

Currency or 
Accounting 
format, £ 
symbol

Percentage 
format, 2 

decimal places

Text format. Note 
left alignment. Will 

not work in 
calculations!

Larger numbers behave similarly: here we are using 23567.19
23567.19 23567.19 23567.2 23567 23,567.19 ¥23,567.19 23567 15/79 2356719%23567.19

General 
format

Number 
format, 2 
decimal 
places

Number 
format, 1 
decimal 

place

Number 
format, no 

decimal 
places

Number 
format, 2 
decimal 

places with 
1000 

separator

Currency or 
Accounting 
format, Yen 

symbol

Fraction 
format, 

up to 2 digits

Percentage 
format, 0 

decimal places

Text format. Note 
left alignment. Will 

not work in 
calculations!



Dates in Excel

Excel stores dates as elapsed days since 1st January 1900. 

1 01/01/1900

100 09/04/1900

1000 26/09/1902

10000 18/05/1927

43101 01/01/2018

23567.19 09/07/1964

23567.19 09 July 1964

23567.19 9.7.64

23567.19 July 9, 1964 (change location to USA)

The diagram on the left shows elapsed days since 
1/1/1900. Each row contains the same data, formatted as 
a number on the left and as a date on the right. 

We are not tied to any one particular method of expressing dates, however. 
Selecting “Format Cells”, then the “Number” tab allows us to use our preferred 
format using dots or slashes or spaces as separators, expressing the month as a 
number, as a word or as an abbreviated word, and so on.

23567.19 09-Juldd-mmm

23567.19 Jul-64mmm-yy

23567.19 09-Jul-64dd-mmm-yy

Yet more options such as those below can be found in the “Custom” section. 



Should you by any chance want to perform calculations to find the difference between 2 dates, a useful trick 
to remember is that the current date can always be inserted in a blank cell using Ctrl and ; (semi-colon). 

If you enter next Christmas in cell A1 and the current date in cell A2, the formula =A1-A2 
will show the number of days until Christmas. Here the formula is in cell A3. Note also 
that you may need to format the destination cell as a number.

Bill wants to know how old he will be on New Year’s Day 2020. He types 01/01/2020 
into one cell and enters his date of birth in the cell below. The formula =cell1-cell2
in the next cell down shows that he will be 21,739 days old.

01/01/2020

25/06/1960

21739

There is a good chance, however, that Bill would rather know what this meant in years, months and days rather 
than a horribly big number of days. In that case he will need to use a different function called DATEDIF (difference 
between dates). This subtracts one date from the other but needs the earlier date first. It also can only return 
years OR months OR days, so needs to be slightly more complicated. To achieve the difference expressed in years, 
months AND days, the DATEDIF function needs to used 3 times in the same formula, to calculate each of the 3 
values and add some text to clarify their meanings. The individual functions are shown in the right-hand column 
below with the resulting values in the left-hand column.

01/01/2020

25/06/1960

59=DATEDIF(A2,A1, "y")

6=DATEDIF(A2,A1, "ym")

7=DATEDIF(A2,A1, "md")

59 years, 6 months, 7 days =DATEDIF(A2,A1, "y") &" years, "&DATEDIF(A2,A1, "ym") &" months, " &DATEDIF(A2,A1, "md") &" days"



So what about the part of the number after the decimal point?

That is Excel’s way of storing times: 0.5 is half a day, or 12:00 hours. 0.75 is ¾ of a day, i.e. 18:00 hours.
For real precision, 
each hour is 1/24 of a day and is represented as the decimal value: 0.041666…
a minute is 1/60 of an hour, or 1/1440 of a day in total, which calculates as 0.00069444…
a second is 1/60 of a minute, or 1/86400 of a day in total, which works out as 0.00001157407…

Let’s go back to our previous number 23567.19 which has a decimal part. Up until now we have only shown the part 
before the decimal point, but presumably the .19 translates as a time on 9th July 1964. How, then, do we show this?

One of the options in the “Custom” category is “dd/mm/yyyy hh:mm” which 
produces the first example below.

23567.19 09/07/1964 04:33dd/mm/yyyy hh:mm

23567.19 09-Jul-64 04:33dd-mmm-yy hh:mm

23567.19 09-July 04:33dd-mmmm hh:mm

23567.19 09 July 1964 04:33dd mmmm yyyy hh:mm

23567.19 09-Jul-1964 04:33:36dd-mmm-yyyy hh:mm:ss

If you prefer a different format you can create your own as shown 
in the other examples above: the right-hand column shows what 
date needs to be typed into the “Type:” field shown to the right.
The last example demonstrates that even seconds can be included.



The appearance of the commands on the Ribbon also varies, depending on the width of the Excel window. 
When the Excel window is too narrow to display everything, the commands adapt; some of them might seem to 
be missing, but the commands are still available.



Clicking on “File” (which looks very similar to the ribbon tabs but is actually very different) opens a screen like this. Click 
on the left-pointing arrow at top left to return to your spreadsheet.

“Info” gives you 
information about 
the workbook 
(strangely enough!), 
and there are 
options for closing, 
saving, printing and 
sharing the 
workbook, exporting 
data from it and 
opening another 
workbook.



If you choose to continue, you will start to look at sorting and filtering data to make it easier to work with. We also 
look at more functions and formulas, Excel’s way of performing calculations and manipulating data.

Title GivenName Surname =CONCATENATE(A2," ",B2," ",C2) Paste as values Remove full stop

Ms. Summer Brown Ms. Summer Brown Ms. Summer Brown Ms Summer Brown

Mrs. Erin Hamilton Mrs. Erin Hamilton Mrs. Erin Hamilton Mrs Erin Hamilton

Ms. Jennifer Hobbs Ms. Jennifer Hobbs Ms. Jennifer Hobbs Ms Jennifer Hobbs

Mr. Edward Carter Mr. Edward Carter Mr. Edward Carter Mr Edward Carter

Mr. Edward Murphy Mr. Edward Murphy Mr. Edward Murphy Mr Edward Murphy

Mr. Kian Lowe Mr. Kian Lowe Mr. Kian Lowe Mr Kian Lowe

Mr. Aaron Richardson Mr. Aaron Richardson Mr. Aaron Richardson Mr Aaron Richardson

Mr. Samuel Short Mr. Samuel Short Mr. Samuel Short Mr Samuel Short

Mr. Alfie Chamberlain Mr. Alfie Chamberlain Mr. Alfie Chamberlain Mr Alfie Chamberlain

Mr. Adam Kelly Mr. Adam Kelly Mr. Adam Kelly Mr Adam Kelly

Mrs. Eva Rees Mrs. Eva Rees Mrs. Eva Rees Mrs Eva Rees

Mrs. Lucy Kelly Mrs. Lucy Kelly Mrs. Lucy Kelly Mrs Lucy Kelly

Mrs. Eva Marsden Mrs. Eva Marsden Mrs. Eva Marsden Mrs Eva Marsden

Mr. Joel Noble Mr. Joel Noble Mr. Joel Noble Mr Joel Noble

Mrs. Millie Hill Mrs. Millie Hill Mrs. Millie Hill Mrs Millie Hill

Mr. Charlie Begum Mr. Charlie Begum Mr. Charlie Begum Mr Charlie Begum

Ms. Rachel Bond Ms. Rachel Bond Ms. Rachel Bond Ms Rachel Bond

Mr. Lucas McKenzie Mr. Lucas McKenzie Mr. Lucas McKenzie Mr Lucas McKenzie

Ms. Erin Cooper Ms. Erin Cooper Ms. Erin Cooper Ms Erin Cooper

Mr. Ethan Wright Mr. Ethan Wright Mr. Ethan Wright Mr Ethan Wright

Mr. Jude Taylor Mr. Jude Taylor Mr. Jude Taylor Mr Jude Taylor

Mr. Ethan Thorpe Mr. Ethan Thorpe Mr. Ethan Thorpe Mr Ethan Thorpe

Mrs. Freya O'Brien Mrs. Freya O'Brien Mrs. Freya O'Brien Mrs Freya O'Brien

Ms. Naomi Walton Ms. Naomi Walton Ms. Naomi Walton Ms Naomi Walton

A couple of easy steps is 
all it takes to convert 
data in 3 cells (Title, 
name and surname) to 
a concise full name and 
title, and remove the 
unnecessary full stop 
after the title.

Look interesting? Keep 
reading!



Here is another spreadsheet showing the use of images, hyperlinks and text formatting.

If you are interested you can 
download this workbook here.

https://www.highamandrushdenu3a.org.uk/documents/populations.xlsx


In this part of the presentation, we will have a quick look at conditional  formatting and 
sorting and filtering data to make it easier to work with. We also make a start on formulas, 
Excel’s way of performing calculations and manipulating data.

A few slides ago we saw how in a couple of easy steps we could convert names split into 3 
columns into a single column with unnecessary characters removed. We will explore the 
processes later in this presentation.

Title GivenName Surname =CONCATENATE(A2," ",B2," ",C2) Paste as values Remove full stop

Ms. Summer Brown Ms. Summer Brown Ms. Summer Brown Ms Summer Brown

Mrs. Erin Hamilton Mrs. Erin Hamilton Mrs. Erin Hamilton Mrs Erin Hamilton

Ms. Jennifer Hobbs Ms. Jennifer Hobbs Ms. Jennifer Hobbs Ms Jennifer Hobbs

Mr. Edward Carter Mr. Edward Carter Mr. Edward Carter Mr Edward Carter

Mr. Edward Murphy Mr. Edward Murphy Mr. Edward Murphy Mr Edward Murphy

Mr. Kian Lowe Mr. Kian Lowe Mr. Kian Lowe Mr Kian Lowe

Mr. Aaron Richardson Mr. Aaron Richardson Mr. Aaron Richardson Mr Aaron Richardson

Mr. Samuel Short Mr. Samuel Short Mr. Samuel Short Mr Samuel Short

Mr. Alfie Chamberlain Mr. Alfie Chamberlain Mr. Alfie Chamberlain Mr Alfie Chamberlain

Mr. Adam Kelly Mr. Adam Kelly Mr. Adam Kelly Mr Adam Kelly

Mrs. Eva Rees Mrs. Eva Rees Mrs. Eva Rees Mrs Eva Rees

Mrs. Lucy Kelly Mrs. Lucy Kelly Mrs. Lucy Kelly Mrs Lucy Kelly

Mrs. Eva Marsden Mrs. Eva Marsden Mrs. Eva Marsden Mrs Eva Marsden

Mr. Joel Noble Mr. Joel Noble Mr. Joel Noble Mr Joel Noble

Mrs. Millie Hill Mrs. Millie Hill Mrs. Millie Hill Mrs Millie Hill

Mr. Charlie Begum Mr. Charlie Begum Mr. Charlie Begum Mr Charlie Begum

Ms. Rachel Bond Ms. Rachel Bond Ms. Rachel Bond Ms Rachel Bond

Mr. Lucas McKenzie Mr. Lucas McKenzie Mr. Lucas McKenzie Mr Lucas McKenzie

Ms. Erin Cooper Ms. Erin Cooper Ms. Erin Cooper Ms Erin Cooper

Mr. Ethan Wright Mr. Ethan Wright Mr. Ethan Wright Mr Ethan Wright

Mr. Jude Taylor Mr. Jude Taylor Mr. Jude Taylor Mr Jude Taylor

Mr. Ethan Thorpe Mr. Ethan Thorpe Mr. Ethan Thorpe Mr Ethan Thorpe

Mrs. Freya O'Brien Mrs. Freya O'Brien Mrs. Freya O'Brien Mrs Freya O'Brien

Ms. Naomi Walton Ms. Naomi Walton Ms. Naomi Walton Ms Naomi Walton



Sorting is most easily achieved from the Data tab of the ribbon.

The screenshot on the right shows 
some random data in columns A to C. 
The data has then been copied into 
columns E to G and sorted 
alphabetically by surname (column F). 
The same data is used in columns I to K, 
this time sorted in descending order by 
the numbers in column K.



When you select a range of cells to sort, and then click the sort button on the ribbon, a small screen opens in the 
centre of the window to allow you to select the sorting criteria. 

This window is context-specific, as can be seen in the 2 screenshots below. 
The block of data contains 2 columns of text and one of numbers. Sorting by 
column A offers the choice of A to Z or Z to A, while the options for column C 
are Smallest to Largest or Largest to Smallest.



The picture on the left shows 4 columns of numbers, as follows:

Column A contains random numbers between 0 and 250, and column B has a more 
limited range of numbers between 0 and 50. Both columns have conditional 
formatting applied, to highlight duplicate values, and it is clear that there are no 
duplicates in column A.
The data has been copied to columns C and D, but this time the data has been sorted 
into ascending order to make it slightly more comprehensible.

This screenshot shows in row 35 
some calculations that have been 
performed on the numbers in each 
column, and in row 36 the formulae 
used to calculate this value 
(maximum, total, average, minimum).

These calculations can all be performed 
without actually typing the formula: the 
“Editing” section of the Home tab of the 
ribbon allows the options shown here 
to be calculated in the active cell.



Conditional formatting is accessed from the Home tab on the ribbon:

The screenshot on the left 
shows that cells can be 
highlighted if they meet certain 
criteria, including greater or 
less than a value, or duplicate 
values as we saw on the 
previous slide.

Examples of the “Data Bars”, 
“Colour Scales” and “Icon Sets” 
formats are shown on the 
right. 

This is just a glimpse into the many ways cells can automatically be formatted 
according to the values within them. If you are preparing a spreadsheet for 
presentation to someone else it is well worth spending a little time applying 
whichever conditional formatting makes the worksheet most comprehensible.

15 15 316

36 36 415

50 50 289

56 56 299

67 67 281

70 70 350

75 75 393

89 89 284

131 131 131

138 138 56

147 147 147

160 160 70

175 175 374

184 184 50

189 189 189

192 192 175

230 230 282

254 254 396

258 258 230

276 276 254

281 281 184

282 282 192

284 284 75

289 289 276

299 299 138

313 313 15

316 316 36

350 350 258

374 374 160

393 393 67

396 396 89

399 399 313

415 415 416



It is even possible to sort by multiple levels, when 
working with large data sets. The screenshot 
below shows that the data are grouped by State, A 
to Z, then within these groupings by product and 
issue, and finally by ZIP code.

To include a secondary or subsequent sort level, simply click “Add Level” and configure it appropriately.

When selecting data to sort, always ensure that you have selected everything, including any empty rows and columns, 
otherwise there is a high risk that your data will become mismatched.



In Excel, the cursor 
normally looks like this:

If you position it over an 
edge of the active cell, it 
changes to this:

This symbol 
allows you to 
move the cell 
elsewhere on 
the worksheet.

If, however, you position the cursor over the bottom-right corner of the active cell it becomes what is 
known as the fill handle, and allows data to be propagated in any direction on the spreadsheet.
Click in a cell with data to be copied, hover the cursor over the cell's lower right corner until the cursor 
changes to a thin plus sign (+) (Excel 2010 or 2013 onwards) or a dark square (earlier versions of Excel), 
and drag up, down, left, or right to fill the cells.

The fill handle looks like a plus sign in Excel 2013, and on the next slide 
we’ll look at what you can do with it.



The fill handle allows you to copy text data into adjacent cells, although if the data to be copied is a date, time 
period, or a custom-made series, the data will be incremented by one instead of just copied when the Fill 
Handle is used. Let’s look at some examples:

Daisy 22/02/17 January Monday 16:05

Daisy 23/02/17 February Tuesday 17:05

Daisy 24/02/17 March Wednesday 18:05

Daisy 25/02/17 April Thursday 19:05

Daisy 26/02/17 May Friday 20:05

Daisy 27/02/17 June Saturday 21:05

Daisy 28/02/17 July Sunday 22:05

Here we can see that the text (Daisy) has been copied down by 
dragging the fill handle downwards. The adjacent columns, 
containing day, date or time data, have all increased as they 
were dragged downwards.
Had the original data been in the lowest row, and the fill 
handles been dragged upwards, the result would have been 
the same, as the values would have decreased going up.

Suppose we wanted the times to 
increase by a minute each time, rather 
than an hour? To achieve this we would 
need to enter the first two times in the 
series, highlight both cells, and then 
drag the fill handle  on the lower cell 
downwards as shown on the right.
Column K shows that increases of 5 
minutes per cell are also easily 
achieved in the same way.

When dealing with numbers, 
Excel will often copy the 
original number if you use 
the fill handle only on the 
first cell. If you enter the 
second value, select both 
cells and use the fill handle 
on the lower cell, Excel will 
create a series using the 
difference between the 2 
values.



Working with Rows and Columns

To insert a new row in a spreadsheet, right-click on a row number, and click Insert. Excel always inserts the row ABOVE 
the row that was clicked on. If you want to continue inserting rows, press the F4 key to insert each additional row.
To delete a row, right-click on the row number, and click Delete. Contiguous rows can be deleted by highlighting them 
before clicking Delete. And non-contiguous rows can be selected by pressing and holding the CTRL key before clicking 
Delete. Don't press the Delete key on the keyboard unless you just want to delete the cell contents and not the actual 
row.
To insert a new column, right-click on a column letter and click Insert. Excel always inserts the column to the LEFT of the 
column that was clicked on. As with rows, if you want to add additional columns after inserting the first column, press 
the F4 key.
To delete a column, right-click on the column letter, and click Delete. Contiguous columns can be deleted by highlighting 
them before clicking Delete. And non-contiguous columns can be selected by pressing and holding the CTRL key. Don't 
press the Delete key on the keyboard unless you just want to delete the cell contents and not the actual column.

If you ever see ##### in a cell, don't panic. It's just Excel's way of telling you that you need to make the column 
wider for the cell contents to display. To make the column wider, place the cursor on the right side of the column 
heading and drag the column edge to the right until the data displays. You can also double-click on the right-hand 
edge of the column heading of a single column or a group of highlighted columns to make it/them fit the contents.



Earlier in this presentation we saw a slide showing how Excel could convert 3 columns of title, name 
and surname into a single column containing all 3 elements of the name. Let’s have a look at this 
process now. The process of joining text is called concatenation, and Excel has a handy CONCAT 
formula (short for concatenate). (All Excel formulas are expressed in block capitals.)

In this case we want to concatenate the contents of cells A2,B2 and C2, so we could use the formula =CONCAT 
(A2,B2,C2). That looks as if it would do the trick, but in fact we have forgotten the space between words and 
the result would be “Ms.SummerBrown”. We therefore need to tell Excel to leave a space between elements 1 
and 2, and another space between elements 2 and 3. We do this by using the formula =CONCAT (A2,” “,B2,” 
“,C2), where the pair of quotation marks with a space between tells Excel we want a space. This formula gives 
the result in the second image below, and if we grab the fill handle in the bottom right corner of cell D2 and 
drag it down, the other cells are also filled. (See the third image below.)

Title GivenName Surname

Ms. Summer Brown Ms. Summer Brown

Mrs. Erin Hamilton

Ms. Jennifer Hobbs

Mr. Edward Carter

Mr. Edward Murphy

Mr. Kian Lowe

Mr. Aaron Richardson

Mr. Samuel Short



We are not quite finished yet, however.
What we see as , Excel sees as what we have asked it to calculate.

If we want to do anything else with this data, we need the cell to contain the data we see, not the formula we used to 
create it. (And in this case we do want to do something else, as we need to remove the full stop).
We do this by selecting the cells that contain the formula by clicking in the middle of the first cell and dragging to the last 
cell, then right-clicking and selecting “Copy” (or using the keyboard shortcut Ctrl & C). The selected area should now be 
surrounded by rotating green dashes. 

Click again in the first cell, right-click and you will see among the options 
“Paste Options”. The second of these shows a clipboard with “123” over it, 
the icon for the process we want to conduct, called “paste values”. If you now 
select this the formulas will be replaced by the calculated values.

It is easy to check if this has 
worked: simply click on one of the 
selected cells and see what 
appears in the formula bar.



There is one final step we need to take to get our data looking the way we want, which is to 
remove the unnecessary full stop after the title in cells D2 to D9.

We do this using the “Replace” action 
from the Editing section of the Home 
tab on the ribbon. “Find” and 
“Replace” may well be familiar 
concepts if you have used a word 
processing program like Word or 
WordPad, or even a simple text editor 
like Notepad.

Select cells D2 to D9, then on the ribbon select “Find & Select”, then “Replace”. A new “Find and Replace” window 
should open with the “Replace” tab already selected. In the “Find what:” box, simply type a full stop, and leave the 
“Replace with:” box blank. Click on the “Replace All” button at the bottom, and all the full stops will disappear.

There will also be a message advising how many 
replacements were made.
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Please note that all the previous examples in this presentation use small data samples in the interests of simplicity and to 
make the screenshots more comprehensible. In the real world, Excel really comes into its own when working with large 
(and very large) quantities of data. 

The screenshot on the left is of the first 40 rows 
of a spreadsheet which actually contains more 
than 500,000 rows and 16 columns(and 
therefore more than 8 million populated cells).

You can download the actual spreadsheet by 
clicking on this link:
https://www.highamandrushdenu3a.org.uk/documents/Consumer_Complaints.xlsx

(Note that large files can take a while to 
download.)

The following slides have screenshots 
illustrating filtering using that workbook.

https://www.highamandrushdenu3a.org.uk/documents/Consumer_Complaints.xlsx


On the Data tab, in the “sort & Filter” section, click on “Filter”.

A dropdown arrow will appear in the heading of each column 
as shown below:

Click on the arrow in the column by which you want to filter, in this case “State” 
(column I) to open a screen as shown on the left.

The bottom part of the screen lists all the available values in the column, each 
with a tick box.
By adding and removing ticks it is possible to select one or more values to see 
only the records containing that value. 
Let us assume that we want to see only records for state AA. We therefore need 
to remove the ticks from all the other values in the list. The simplest way to do 
this is to click on the tick box at the top of the list, next to (Select All), to 
deselect all the values. Thereafter simply click on the box next to AA and then 
click the “OK” button at the bottom of the filter screen.



Once the filter is applied, you will see the following changes to the screen:

The row numbers of the 
filtered rows turn blue.

The taskbar shows how 
many rows are in the 
selection.

The column header has an 
icon to show that it is filtered, 
and if you hover over the icon 
a screen shows the values by 
which it is filtered.



Related things we are often asked are how to display only the active cells and how to prevent other people changing the 
data.

The simplest method to display only active cells is as follows:
1. Click on the header of the first column you want to hide.
2. Simultaneously click the Ctrl, Shift and right arrow keys on your keyboard to highlight all columns to the right.
3. Right-click anywhere in the highlighted area and select “Hide”.
4. Click on the row number of the first row you want to hide.
5. Simultaneously click the Ctrl, Shift and down arrow keys on your keyboard to highlight all rows below.
6. Right-click anywhere in the highlighted area and select “Hide”.

If you are going to print the active cells then it is simpler to open the Page Layout tab, select all the active cells, 
then on the ribbon click on “Print Area” and then “Set Print Area”. Only the selected cells will be printed when 
the time comes, so don’t forget to change this setting if you add rows or columns.

If you intend to paste the active cells into a Word or Publisher 
document or PowerPoint presentation and worry that end users will be 
able to change your data, then it is worth considering pasting your 
data as a picture rather than Excel data which can be altered.
When you right-click prior to pasting you should see this screen:
If you select the circled option (with a picture on the clipboard), your 
data will be pasted as an image.



We have in the past touched on the fact that more recent versions of Office applications are often more advanced 
than older versions and some of the newer features are not backwards-compatible. This is particularly true of 
Excel, where new formulas (or formulae to be more pedantic) are introduced with most new versions.

This was brought home to me a couple of years ago.  On my home computer I had prepared a spreadsheet for 
use on the laptop used for scanning the new membership cards at the monthly meetings, and tested it quite 
extensively.  I took it on a flash drive and loaded it on to the U3A laptop but it did not work.  I tried it on my own 
laptop, which I had with me, and it worked well there as well.  I ended up taking the U3A laptop home with me 
to see what the problem was.

I looked up the error code and discovered that it meant that Excel did not recognise the formula I was using:
=IFERROR(IFS($A2=" ",” ",$B2="NO",VLOOKUP($A2,Members!$B:$S,4,0),$B2="YES",VLOOKUP($C2,Members!$A:$S,5,0))," ")

A little further research revealed that the IFS function in my formula was not introduced until Excel 2019 (which I 
have on my PC and my laptop) so was not recognised in the Excel 2016 on the U3A laptop.

So how did I solve this problem?  I could have changed the formula to 3 nested IF functions instead of 1 IFS 
function, but this would have made the formula much more complicated (believe it or not!) and an eBay 
purchase of Office 2019 for the U3A laptop seemed a much better idea at £3.49!



THE END

©2018 Jim Morrison

Additional recommended resources:

For a comprehensive guide to Excel formulas and functions, with examples and explanations of every formula, 
download the Excel Functions Bible from www.rondebruin.nl/efb/efb.htm (a Dutch site, but it is in English).

Whatever your Excel problem the chances are that you will be able to find at least help, if not the answer, at 
www.mrexcel.com. 

http://www.rondebruin.nl/efb/efb.htm
http://www.mrexcel.com/

